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28 Chapter 2: Exploring The Basics

A quick tour

As a quick introduction to MC11, we'll take a brief tour of the program. Begin 
with a double click on the MC11 icon.

To begin the tour, we'll load one of the sample circuit files supplied with MC11. 
Choose Open from the File menu. When the file prompt comes up, type in the 
file name MIXED4. Click Open. The program loads the circuit and displays it.

Figure 2-1 The MIXED4 sample circuit

The circuit uses an analog TTL inverter to drive a digital three-stage synchronous 
divide-by-five counter. The digital clock input to the first JK flip-flop is driven by 
the analog TTL output, while the CLR initializing pulse for the flip-flops comes 
from a digital source, U2. The CLK inputs are connected together with a .TIE 
command. The flip-flop preset nodes are connected together by a wire and the 
node is labeled PREB with grid text. This node is initialized to a '1' state with 
an .IC command. The digital source states are specified in a .DEFINE command 
statement located in the schematic text area. The text area is a private cache in 
each schematic for storing text. You can toggle the display between the drawing 
and text areas by pressing CTRL + G or by clicking on the Text tab in the lower 
page scroll bar. This combination of analog and digital circuitry is easily handled 
by the program, since it contains a native, event-driven digital simulation engine, 
internally synchronized with its SPICE-based analog simulation engine.
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Figure 2-2 The Analysis Limits dialog box 

Select Transient from the Analysis menu. MC11 presents the Analysis Limits 
dialog box where you specify the simulation time range, choose plot and simula-
tion options, and select waveforms to be plotted during the run.

Here we have chosen to plot the analog voltage waveforms at the input pulse 
source, the output of the analog section, and several of the digital waveforms. In 
general, MC11 can plot any expression using as variables any node voltage or 
state or any device terminal voltage or current. Here are a few other expressions 
that could have been plotted in this circuit.

 d(CLR)  Digital state waveform on node CLR.
 hex(CLR,PB,1,2) Hex waveform at nodes CLR,PB,1,2.
 vbe(q3)  Base-emitter voltage of transistor q3.
 I(VCC)  Current through the VCC source.
 PG(VCC)  Power generated by the VCC source.
 qbe(q1)  Charge stored in the base-emitter cap of q1.
 cbc(q4)  Base-collector capacitance of q4.

There are a great many other variables available for plotting. Click the right 
mouse button in any of the Y Expression fields to see a list of variables available 
for plotting or printing. Click outside of the menu to remove it.

Transient 
analysis display
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30 Chapter 2: Exploring The Basics

Now let's run the actual simulation. Click on the Run button  or press F2 
to start the simulation. MC11 plots the results during the run. The run can be 
stopped at any time by clicking the Stop button  or by pressing ESC. 

Figure 2-3 Transient analysis of the circuit

The final waveform plots look like Figure 2-3. Each waveform can have a unique 
token, width, pattern, and color. These options are set from Options / Default 
Properties for New Circuits for new circuits and from the Properties (F10) dia-
log box for the current circuit. Waveforms can be grouped into one or more plots. 
Grouping is controlled by the plot number assigned to each waveform. The plot 
number is the number in the P column of the Analysis Limits dialog box. You can 
assign all the waveforms to a single plot, or group them into as many plots as will 
fit on the screen. To assign several waveforms to the same plot, give them all the 
same plot number. To create several plots, use different plot numbers. To disable 
plotting a waveform, enter a blank for the plot number. 

In this example, all waveforms in the plot group share a common vertical scale. 
To use different scales disable the Plot Properties (F10) / Scales and Formats / 
Same Y Scales for Each Plot Group option and enter the scales you want in the 
Y Range field. All waveforms in a plot group share the horizontal or X scale.

Digital and analog waveforms may be mixed or separated. Separated digital 
waveforms show the expression on the left, adjacent to the plot. Mixed digital 
waveforms display the expression at the bottom of the plot along with the analog 
expressions in the order of their occurrence in the Analysis Limits dialog box. 
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The same rich set of expressions available in transient analysis is also available 
in AC analysis. In addition, these operators are very useful:

 db(c) Finds the decibel value of the complex expression c.
 re(c) Finds the real value of the complex expression c.
 im(c) Finds the imaginary value of the complex expression c.
 ph(c) Finds the phase in degrees of the complex expression c.
 gd(c) Finds the group delay of the complex expression c.
 inoise Finds the input noise reflected to the input node.
 onoise Finds the output noise at the output node.

Click on the Cursor mode button  in the Tool bar or press F8. In this mode, 
two cursors are placed on the graph and may be moved about. The table below 
the plots show the waveform values at each of the two cursors, the difference 
between them, and the slope. The display should look like this:

Scope in Cursor 
mode

Figure 2-12 Cursor mode

The left mouse button controls the left cursor and the right button controls the 
right cursor. The cursor keys LEFT ARROW and RIGHT ARROW also control 
the cursors. As the cursors move around, the numeric display continuously up-
dates to show the value of the waveforms, the change in waveforms between the 
two cursors, and the waveform slope between the two cursors. The optional cur-
sor trackers also track the X and Y values as the cursors are moved.

Left cursor tracker

Right cursor tracker
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36 Chapter 2: Exploring The Basics

The Optimizer
Note from Fig 2-10 that the load resistors R1 and R3 are set to RL, a symbolic 
variable defined as 1.32K. We'll optimize the value of RL to maximize the gain at 
1MHz. Press CTRL + F11 to bring up the Optimizer. It looks like this:

These settings seek the value of RL that maximizes the performance function 
Y_Level(DB(V(OUT1)),1,1,1E6). From Fig 2-12 the value of DB(V(OUT1)) 
at 1.0MHz before optimization is 40.9dB. Click on the Optimize button. The 
optimizer whirs and chugs and eventually spits out an optimal value of 2.3K. 
Click on the Apply and Close buttons. Press F2 to rerun the analysis, then F8 and 
you'll see that with RL=2.3K, DB(V(OUT1)) at 1MHz is now 45.4dB, a net gain 
of 4.5dB. Press F3 to exit the AC analysis routine. Choose Close from the File 
menu to unload the circuit. 

Figure 2-13 The Optimizer dialog box

Figure 2-14 The optimized gain curve
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Choose Open from the File menu to load a new circuit, then type "CURVES" 
and click the Open button.

This creates a set of bipolar transistor IV curves. Choose DC from the Analysis 
menu. Click on the Run button. The plot looks like this:

Figure 2-16 The IV curves of a bipolar transistor

Figure 2-15 The CURVES circuit

DC analysis

Press F3 to exit the DC analysis, then unload the circuit with CTRL + F4.
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38 Chapter 2: Exploring The Basics

Press CTRL + O, then type "MIXED4". Click Open. Choose Probe Transient 
from the Analysis menu. If needed, MC11 runs the analysis, saves it to disk, and 
presents the Probe display. You scroll the schematic or pan it with a click and 
drag of the right mouse button and probe any node or component with a click of 
the left mouse button. Move the mouse to the pulse source and click the left but-
ton on the dot near the IN node, and its voltage waveform is fetched from disk 
and plotted. Click the mouse on the OUT node, CLKB pin, J pin, and CLR node 
of the first flip-flop. This plots the analog input and output, and the clock, J, and 
clear digital waveforms. Analog and digital waveforms are placed in the same 
plot when the Separate Analog and Digital option on the Probe menu is not 
checked.

Probing on a node produces either analog node voltage waveforms or digital 
node state waveforms. Probing between the leads of an analog device produces 
pin to pin terminal voltage waveforms such as VBE(Q4). Probing on a digital de-
vice produces a list of the node names. Selecting a node name from this list plots 
the digital waveform on that node. For analog parts, current waveforms are also 
available, as are charge, capacitance, inductance, flux, and all the usual variables. 
In addition, you can enter expressions involving circuit variables.

Press F3 to exit the Probe routines and return to the Schematic editor. Remove 
the circuit with CTRL + F4. This completes the quick tour. For more extensive 
tours of MC11, see the Demo options in the Help menu.

Figure 2-17 The Probe display

Probe
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62 Chapter 3: Creating and Editing Simple Circuits

Now press CTRL + C to copy the selected region to the clipboard. Move the 
mouse to the right of the battery and click the left button. This moves the inser-
tion point. Press CTRL + V to paste the clipboard contents to the insertion point. 
Your circuit should now look like this:

The selected region has been copied, or pasted, from the clipboard to the circuit.

Figure 3-13 Selecting a region for copying to the clipboard

Figure 3-14 After pasting the clipboard contentsSam
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Selection

Single objects or entire regions may be selected for editing, deleting, moving, 
rotating, mirroring, stepping, or copying. They may be selected or deselected 
individually or as a group. Clicking on an object or region while the SHIFT key 
is down toggles the selection state. If the object or region was formerly selected, 
it becomes deselected. If it was formerly deselected, it becomes selected.

To illustrate, press the SHIFT key and hold it down. Click on the Q7 transistor in 
the selected group. Be careful not to click on the name Q7 as that will select the 
PART attribute rather than the part itself. Release the SHIFT key and the circuit 
looks like this:

The Q7 transistor is now deselected. If you press the Del key, Q7 will remain but 
the rest of the selected region will be deleted. Press the SHIFT key and click the 
same transistor and it is again selected. If you now press the Del key, the entire 
selected region will be deleted. 

By using partial selection, virtually any subset of a schematic can be selected for 
editing, copying, deleting, or moving.

To complete this part of the tutorial, click on the Revert option from the File 
menu to restore the DIFFAMP circuit.

Figure 3-15 Partial selection using SHIFT + mouse click
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82 Chapter 4: Transient Analysis

The Plot Properties dialog box

Curve display and format can be changed with the Plot Properties dialog box. 
Press F10 to invoke the dialog box for the plot. It looks like this:

Figure 4-6 The Properties dialog box

Select V(OUT) from the Objects section of the Colors, Fonts, and Lines panel, 
and from the Curve Line section select a width of 5. Click on V(IN) and select 
the third pattern in the list. Click the OK button. Disable tokens by clicking the 

 Tokens button in the Tool bar. The screen should look like this: 

Figure 4-7 Using line width and pattern
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Let's experiment with some of the other options. Click on the Data Points button 
. This toggles the display of marker icons for the calculated data points. Since 

the option was initially disabled, clicking the button enables it, and the data point 
marker icons are added producing a plot that looks like this:

Data Points Op-
tion

Figure 4-8 The plot with the Data Points option enabled

Since the simulator uses a variable time step algorithm to minimize errors and 
accelerate the run, the actual time points will not be regularly spaced. The data 
point markers are placed at the actual computed time points. There are at least 
two situations where you might want to see these:

 Inadequate curve sampling: This can happen in transient analysis when the  
 simulator flies past a switch threshold. It may also happen that you want  
 more data points to "fill in" source curves that look choppy. Even though the  
 charge error is strictly controlled by the internal truncation error routines, the  
 data sampling may seem inadequate. Data point icons show where the data  
 points are and whether more will help. In AC analysis, your plot may miss a  
 steep spike on a narrow pass or reject band. Data point icons show whether  
 the simulator actually made a calculation within the band. 
 
 Identifying real curve spikes: Sometimes you see spikes on curves. If the  
 curve changes direction from one data point to the next, it's likely the spikes  
 are simply artifacts of the integration routines. The only way to tell is to mark  
 the data points. If they are integration artifacts, you can reduce them by 
 decreasing RELTOL or the minimum time step or both. 
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84 Chapter 4: Transient Analysis

To illustrate some other options, click on the horizontal axis grid  and vertical 
axis grid  buttons. The plot should now look like this:

Experimenting 
with the options

Press F9, then enable the Operating Point and Operating Point Only options. This 
tells the program to do an operating point calculation, and then stop. An operat-
ing point calculation sets all sources to their defined initial values, removes all 
capacitors, and replaces all inductors with short circuits. It then calculates the 
steady-state DC values of the state variables (node voltages, inductor currents 
and digital states) at the initial time point. This set of values is referred to as the 
DC operating point. Press F2 to do the operating point only run. Since we're do-
ing only an operating point, no plot will appear. Exit the analysis by pressing 
F3. Click on the Node Voltage  button and MC11 displays the last calculated 
states and voltages. In this case, since we just completed an operating point only 
calculation, these are the operating point values. 

Figure 4-9 Adding grids to the plot
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96 Chapter 5: AC Analysis

What happens in AC analysis

In AC analysis the optional DC operating point and optional Periodic Steady 
State are first computed. Digital nodes stabilize and potentially affect analog 
nodes to which they may be attached. Linearized, small signal AC models are 
then created for each component and are entered into a set of linear network 
equations. These are repeatedly solved at many frequency points to obtain the 
small signal response of the circuit to whatever AC excitation is present in the 
circuit. The linearized AC model of a digital component is an open circuit. This 
means that digital parts are ignored during small signal analysis. 

The excitation is supplied by one or more independent sources in the circuit. 
Pulse and Sine sources provide a fixed, real, 1.0 volt AC signal. User sources 
provide a signal comprised of the real and imaginary parts specified in their files. 
The SPICE independent sources, V and I, provide user-specified real AC signal 
amplitudes. Function sources can create an AC signal only if they have a FREQ 
expression. These are the only sources that generate AC excitation. 

AC analysis represents the excitation and system variables (node voltages and 
various branch currents) as complex quantities. Operators, such as RE (real), IM 
(imaginary), dB (20*Log()), MAG (magnitude), PH (phase), and GD (group de-
lay) are provided to print and plot these complex quantities.

To explore AC analysis, load the file DIFFAMP. It looks like this:

Figure 5-1 The DIFFAMP circuit
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Choose AC from the Analysis menu. When the AC Analysis Limits dialog box 
comes up, the fields should look like this:

Figure 5-2 The AC Analysis Limits dialog box

Command buttons 

Figure 5-3 The AC analysis plot

Numeric limits Options

Curve options 

Expressions 

In this circuit, we have a single source providing a 1.0 volt AC signal. The dialog 
box instructs MC11 to sweep the frequency from 1K to 10Meg and produce plots 
of the magnitude of the voltage at the node OUTA and the phase angle of the 
voltage at node OUTB. Press F2 and the result looks like this:

Auto size

Re-size
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Experimenting with options and limits

The small squares on the plots in Figure 5-3 mark the actual points calculated by 
MC11. We can produce a smoother plot at the expense of more data points by 
reducing the Maximum change % value from 5% to 1%. Press F9 to display the 
AC Analysis Limits dialog box. Double-click the mouse in the Maximum Change 
% field and type "1". Press F2 to run the analysis. It looks like this:

Figure 5-4 The plot with Maximum change % set to 1%

The lower value of 1% produces a smoother plot by calculating more data points. 
The current Frequency Step method is Auto. In this mode, the frequency step is 
automatically adjusted to restrain the point-to-point change of both the vertical 
value and the angle of the plot itself to less than the specified maximum change. 
The Auto method produces the smoothest plot at the lowest computation price for 
most curves.

This analysis uses 1% and generates about three times the number of data points 
as the 5% analysis. Since the analysis time increases in direct proportion to the 
number of data points, it is wise to keep the Maximum change % as large as pos-
sible.  A value of 1 to 5 is usually suitable. If the first curve is very flat, you may 
want to try a fixed frequency step method.

Let's try one of these methods. Press F9 to display the Analysis Limits dialog 
box. Click in the Frequency Range list box. When the list drops down, click on 
the Log option. Press F2 to start the run. The result looks like Figure 5-5.
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104 Chapter 5: AC Analysis

Figure 5-5 The plot using the log option

Figure 5-6 The plot using the linear option

The constant horizontal distance between data points is achieved by making each 
new frequency a product of the prior frequency and a fixed multiplier. Since the 
lowest frequency forms the base that is multiplied, it must not be zero.

The Linear option is only used when the X axis is linear. To illustrate, press F9 
and edit the Frequency Range field to 1E7,0. Change the Frequency Range meth-
od to Linear and change the X Log/Linear button states of the first two curves to 
linear. Press F2 to run. The result looks like Figure 5-6.
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Numeric output

To obtain a tabulation of the numerical values simply click the Numeric Output 
button  for each curve for which numeric output is desired. Do that now for 
the first two curves. Press F9, then enable the buttons. Press F2 to run the analy-
sis. All text or numeric output is directed to the Numeric Output window and to 
a disk file with the name DIFFAMP.ANO. Press F5 to see the window. The first 
part shows the results of the DC operating point. Scroll down to the Waveform 
Values section. The display should look like this:

A printout of the data in the Numeric Output window may be obtained from the 
Print option of the File menu.

To display the Analysis Plot window, press F4, or click on the Analysis Plot 
button .

To display the Numeric Output window, press F5, or click on the Numeric Output 
button . 

Figure 5-7 Numeric output
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106 Chapter 5: AC Analysis

Noise plots

MC11 models three types of noise; thermal, shot, and flicker noise.

Thermal noise is produced by the random thermal motion of electrons and is al-
ways associated with resistance. Discrete resistors and the parasitic resistance of 
active devices contribute thermal noise.

Shot noise is caused by a random variation in the production of current from a 
variety of sources including recombination and injection. It is usually associated 
with dependent current sources. All semiconductor devices generate shot noise. 

Flicker noise comes from a variety of sources. In BJTs, the source is contamina-
tion traps and other crystal defects that randomly release their captured carriers.

Noise analysis computes the contribution from all these sources as seen at the 
input and output. Output noise is calculated at the output node specified in the 
Noise Output field. To plot it, specify ONOISE as the Y expression. Input noise 
is calculated at the same output node(s) specified in the Noise Output field, but is 
divided by the gain from the node(s) specified in the Noise Input field to the out-
put node. To plot or print input noise, specify INOISE as the Y expression.

Press F9 and edit the analysis limits to match Figure 5-8. Be sure to disable nu-
meric output for the first two curves and to select the Log option.

Figure 5-8 The Analysis Limits for Noise plots
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Press F2 to run the analysis. The results look like this:

Figure 5-9 Plots of input and output noise

In this circuit, thermal noise is generated by the resistors. Shot and flicker noise 
are generated by the transistors.

Because the equations are structured differently for noise, it is not possible to 
simultaneously plot noise variables and other types of variables such as voltage 
and current. That is why we disabled the other curves by placing a blank in their 
P fields and disabling their Numeric Output field. If you attempt to plot or print 
both noise and other variables, the program will issue an error message.

Noise is an essentially random process and as a result carries no phase informa-
tion. For this reason, noise is defined as an RMS quantity. Thus the phase (PH) 
and group delay (GD) operators will not produce meaningful results when plot-
ting noise. With noise, only magnitudes are meaningful.

The units of noise are V / sqrt(Hz).Sam
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108 Chapter 5: AC Analysis

Nyquist plots

A Nyquist plot is easy to generate. Edit the analysis limits to look like these.
Here we have enabled the last curve and disabled the other curves and selected 
log stepping.

Figure 5-10 Analysis limits for the Nyquist plot

Press F2 to run the analysis. The result looks like this:

Note that the X expression in this case was RE(V(OUTA)), not F as it usually is. 
In general, it can be any expression involving any AC variable.

Figure 5-11 The Nyquist plot
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Smith charts

To generate a Smith chart plot, use the  option from the chart type selector, 
adjacent to the P column. Here is how the Analysis Limits dialog box looks when 
set up to create a Smith chart plot for S22, using the SMITH.CIR file.

Figure 5-12 Analysis limits for the Smith chart

Note that when the Smith chart option is selected, the X expression must be F, so 
this field is not available for editing. Here is the resulting S22 plot.

Figure 5-13 Smith chart plot of S22

Chart type selector
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110 Chapter 5: AC Analysis

Polar plots

To create a polar plot, use the polar plot option, . Here is how the dialog box 
appears when set up to create a polar plot for S21 using the SMITH.CIR file.

When the polar plot option is selected, the X expression must be F, so this field is 
not available for editing.  Here is the resulting polar plot.

Figure 5-15 Polar plot of S21

Chart type selector

Figure 5-14 Analysis limits for a polar plot
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Magnifying

Click the left mouse button just above and to the left of the large peak of the 
V(B) curve. While holding the left button down, drag the mouse down and to the 
right to create a magnification box like the one shown in Figure 7-3.

Figure 7-4 The magnified region

Release the button and MC11 scales the plot to match the outline of the box.

Figure 7-3 Magnifying a plot region
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Figure 8-14 Probing the NAND3

Figure 8-13 Probing the second JK

Click on the X12 NAND3. The system loads and displays its schematic. All of its 
nodes are available to the external pins, except the internal nodes of the 3-nand 
stack. Click on one of these, like the drain node of M6. The display should now 
look like this:

Suppose you want to return to the JK level. Click on the Up Tool Bar button  
or press ALT + Up Arrow. Click on it again and you are back at the top level 
schematic.
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Stepping in transient analysis

To see how stepping works in transient analysis, enable the Yes option in the Step 
It section of Parameter panel 1, click OK, and press F2 to start the run. It looks 
like this:

Figure 9-2 Stepping BF in four transistors simultaneously 

In this run, each device which uses the N1 model, which includes the transis-
tors Q1, Q3, Q4, and Q5, has its BF (forward beta) stepped through the values 
100, 150, ... 350. To see which devices use N1, double-click on each device in 
the schematic to see its Attribute dialog box. From the results, it seems the offset 
voltage of V(OUTA,OUTB) is insensitive to large changes in BF, if all four de-
vices have the same value. 

Now we'll step the BF of just Q1 to see how the circuit tolerates small relative 
differences in beta. Press F11 to access the Stepping dialog box. Click on the 
Component item in the Parameter Type group. From the Step What list, click on 
Q1 and from the parameter list select BF. Type "250" in the From field, "255" in 
the To field, and "1" in the Step Value field. Click on the OK button and press F2 
to start the run. The plot, shown in Figure 9-3, demonstrates the circuit sensitiv-
ity to differential beta. When Q1's BF changes from 250 to 255, while all other 
transistors have constant BF, large shifts occur in the output offset of both curves 
V(A,B) and V(OUTA,OUTB). 
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To illustrate stepping in DC, press F3 to exit the analysis. Press ALT + 3 for DC 
analysis. Press F11, click on the Linear option, Click on the Yes option, click OK, 
then press F2 to start the DC run. It looks like this:

To illustrate multiple parameter stepping, press F11, click in the Yes option in the 
Step It field of parameter 2. Press ENTER, then F2. The run looks like this:

Figure 9-8 Stepping multiple parameters

Here we've simultaneously stepped BF and NF of all transistors using the N1 
NPN model. Nested stepping was selected, and each parameter has six values, so 
6•6 = 36 runs were done.

Figure 9-7 DC analysis linear stepping
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Text stepping

Text can also be stepped. Consider the circuit below:

Here Q1's model is set to N1, which is defined as N1A via the statement,

.DEFINE N1 N1A

If we step N1 through a list that includes N1A and N1B, we get two simulations. 
One is for the case when N1 is N1A and uses the N1A model parameter set. The 
second is for the case when N1 is N1B and uses the N1B model parameter set. 
The Stepping dialog box for this case is shown below.

Figure 9-9 Stepping the N1 variable

Figure 9-10 The Stepping dialog box for text stepping the N1 variable
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An example

To illustrate the Monte Carlo features, load the file CARLO4.CIR. This file con-
tains a simple pulse source driving an RLC network. The circuit looks like this:

Figure 10-2 Monte Carlo options

Figure 10-1 The CARLO4 circuit

Select transient analysis and then using the mouse, click the Options item from 
the Monte Carlo menu. It should look like this:

Sam
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A transient analysis example

To see how the animation mode works in transient analysis, click on Open under 
the File menu and load the circuit ANIM3. The ANIM3 circuit uses the seven 
segment components to display the outputs of three 7448 seven segment decod-
ers. The circuit should appear like this:

Figure 14-2 The ANIM3 circuit

Select Transient from the Analysis menu. Close the Analysis Limits dialog box. 
Click on the Scope menu and select Animate Options. The Wait setting for the 
ANIM3 circuit is currently set to Wait for Time Delay and the Time Delay has 
been defined as 0.2. This means that a single data point will be calculated every 
0.2 seconds. Click OK. Hit the F2 key to run the simulation. The resulting values 
will be displayed in the plot and on the schematic. Notice that both the digital 
states on the schematic and the seven segment displays are updated with each 
data point. Figures 14-3 and 14-4 display the simulation results at two separate 
times in the circuit.

For animate mode, a split screen should be used to be able to view both the wave-
form plot and the schematic at the same time. This can be done by selecting Tile 
Vertical or Tile Horizontal under the Windows menu. The schematic can be 
moved within the window by dragging with the right mouse button.
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The waveforms in the plot also show the output values of the Ina stimulus (nodes 
21-18), the Inb stimulus (nodes 28-25), and the resulting output (nodes 35-32) of 
the adder. As can be seen in the figures, it is much easier to view the basic output 
through the animation components than through the actual waveforms.

Figure 14-3 Animation mode results at 200ns

Figure 14-4 Animation mode results at 700ns
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A Dynamic DC example

To see how the animation mode works in Dynamic DC analysis, click on Open 
under the File menu and load the circuit ANIM5. The ANIM5 circuit shows how 
to use the voltage and current meters, analog Bar, DPST switch, and motor. Run 
Dynamic DC. The circuit should appear like this:

Figure 14-5 The ANIM5 circuit

In Dynamic DC MC11 does a DC operating point calculation every time a 
change is made to the circuit. It continually updates the display. In this circuit 
we have a 1.0 volt and a 2.0 volt battery connected through a SPDT switch to 
a motor that rotates at 1RPM per input volt. The rotational velocity (in volts) is 
measured by a digital voltmeter. There is also an analog bar, an analog voltmeter, 
a stoplight, an LED, and seven-segment displays showing the addends into and 
their sum from a digital 4-bit full adder.

The motor rotates at 2volts*1RPSV = 2 RPS (revolutions per second). The ana-
log bar is at 8/10 of its full height.

Double click on the S1 switch. It changes state. Because S2 is ganged with it, S2 
also changes state. 

Sam
ple




